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Week 1: Exercise 1 – Introduction to ArcMap and ArcCatalog 
 
ArcGIS is a type of software used for GIS (Geographical Information Systems) that enables the user to work 
with spatial data.  This lab will provide you with an overview of the different functions of ArcGIS and 
demonstrate the different types of applications for GIS.    
 
ArcGIS is composed of three components: 
 

ArcMap – This is the program that you will primarily be using for this exercise and other analyses.  
ArcMap is where you can display data, make maps, label features and query data. 

ArcCatalog – This is basically a program like Windows Explorer, but built specifically for ArcGIS.  
Use ArcCatalog when you want to organize, copy or paste, or preview data. 

ArcToolbox – Includes tools that you will need for more advanced types of analyses such as combining 
data sets, or clipping data such as clipping county soil data to just the town boundaries of Brunswick. 
 
Exercise 1 – Using ArcMap and ArcCatalog to display and preview data 
Exercise 2 – Using ArcMap to display data 
Exercise 3 – Using ArcMap and ArcToolbox to analyze data  
 
In Exercise 1, you will start by exploring data for Brunswick and learn how to display data in ways that make it 
more understandable.   
 
Step 0 – Map your student folder on the Microwave network drive 
 
This is where all the files for this exercise are 
stored, and where you will store your work for 
Exercises 2 and 3. 

• Open My Computer. 
• From the Tools menu, choose Map 

Network Drive. The Map Network 
Drive window will appear. 

• Next to "Drive:" select a drive letter. 
Any letter not already used is OK, but 
choose a letter that you will remember 
so that you can use this letter EVERY 
TIME you link to your student folder to 
work on the GIS projects; because the 
data in your ArcMap documents will be 
linked to this drive, if you use a different 
letter next time you map your folder, the ArcMap file won’t “know” where the data is and this will cause 
problems.  Write down which drive letter you used.  _________ 

• Next to "Folder:", type: \\microwave\courses\es201 
• Click on the Finish button. A new window for the course folder, through which you can access your 

student folder, will appear on your desktop. An icon for the course will also appear (“mount”) in your 
list of drives in My Computer.  
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Step 1 – Start ArcMap 
 

• Click on Start>Programs>ArcGIS>ArcMap. 
• When the ArcMap dialog appears, click "A new 

empty map," then OK. 
 
You will see the interface of the ArcMap application.  

• From the File menu, choose Open.  
• Navigate to the Exercise1 folder in your student 

folder on our Microwave Course Directory  
• Click on Merrymeeting_Bay.mxd.  Click Open.   

 
When the map opens, you see a map of Merrymeeting Bay. 
Don't worry if your ArcMap interface looks different from 
the graphic below (see page 3). For example, your ArcMap 
window may be larger or smaller. The graphic shows 
toolbars at the top and bottom of the ArcMap window. 
Your ArcMap may have these toolbars in other locations, 
or some of the toolbars may not be displayed at all. These 
differences have no effect on the results of the exercise. 
 
 
 
 
The ArcMap Window 
 
Whenever you work in ArcMap, you are working with a map document.  A map document has the .mxd file 
extension.   
 
The ArcMap window displays geographic features organized into layers. Each layer is a particular theme of 
information such as roads or rivers. 
 
The area on the left side of the ArcMap application window contains the list of layers and is called the Table of 
Contents. The area on the right side of the application window contains Map Display for all of the active layers 
listed in the Table of Contents.  
 
For instance, the roads layer is composed of line features (represented with lines) grouped into a layer called 
Primary_roads. The towns are contained in a layer called Towns, which is made up of polygon features.  
 
The ArcMap window also contains drop down menus and toolbars such as the Standard Toolbar that allows you 
to work with the data. 
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Map Display 
 
 
 
 
 
Main Menu  
 
Tools toolbar 
 
Standard 
toolbar 
 
 
 
 
 
 
Table of 
Contents 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2 – Displaying layers 
 
You can make any of the layers visible (active) or hidden by clicking on the box next to the layer name. 
 

• Check the box next to the Primary_roads layer. The map will re-draw, and the roads will display as 
lines. 

Note that you cannot turn on the Brunswick_roads layer.  This is set so that it will only display when you are 
zoomed in closer to Brunswick. 
 
Many of the tools you use in ArcMap to look at features and identify features are similar to tools in programs 
such as MapQuest or Google Maps, such as Identify, Zoom, and Pan. 
 
 
 
 



- 4 -                             Perspectives in Environmental Studies GIS Lab                         E. Johnson, N.Olmstead                 
 

 
 
Step 3 – Identify geographic features 
 

In ArcMap, you can find out what features are just by clicking on them in the map display area. 
 

First, you'll zoom in so you can see individual features more clearly. To do this, you will access a previously 
created bookmark that stores a specific geographic region.   

• At the top of the ArcMap Window, select Bookmarks,  
• Select Brunswick.  

 
 
The display zooms into Brunswick. Notice that the “Brunswick_roads” layer is visible and that you can see 
more streets in Brunswick.  The “Primary_roads” layer is no longer visible.  Labeling streets at this scale would 
make it difficult to read the names of the streets, so the Brunswick_roads labeling feature has been set to only 
display street names when you are zoomed in closer than 1:20,000. 

• Click on the zoom in button  until the scale reads greater than 1:20,000 (a number smaller than 
20,000).  The road names should now be visible.  [If the Tools toolbar, which contains this button, is not 
visible, right-click the menu bar to the right of the Help menu and select Tools.]  
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Step 4 – Using the Identify button 

• On the Tools toolbar, click the Identify button . The Identify window opens.   
• In the Identify from drop-down menu, select Brunswick_roads.   
• Click on a Brunswick road.   

The Identify window resets; it displays all the attributes for the Brunswick road you selected.  
 

 
 

• In the Identify window, from the Identify from dropdown list, choose <All layers>,  
• Click any of the roads. 

 
The Identify window now contains the attributes for the road you have clicked on and all the other layers that 
display in that area. You may have to enlarge the Identify window to see all attributes. 

• Continue identifying other features in the display area by clicking on them with the Identify button.  
When you are finished, close the Identify window. 

 
Step 5 – Using the Pan Tool 

• Using the pan tool , move the map until downtown Brunswick is in the center of the map. 
 
Step 6 – Use the Zoom In Button 

• On the Tools toolbar, click the Zoom In button .  
• Draw a box around where you think Bowdoin College is located.  ArcMap zooms in to this area.   

 
Once you have zoomed in to a scale larger than 1:5,000, the layer brunswickdrgclip.tif displays.  This layer is a 
raster image, or a scanned image of a USGS topo map.   
 
Use this to find Bowdoin College.  Look at some of the details of this map.   
Can you find Druckenmiller Hall?  (this is a “trick” question) 
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Step 7 – Examine attribute information 
 
Attribute data provides information about spatial data.  For example – the location of a house is spatial data – 
the color or owner of the house is attribute information.  ArcGIS allows the user to look at this attribute data –
the “data behind the data.”  This is what makes GIS a powerful tool for applications like environmental analyses 
and land use planning.   
 
 

• Turn off the layer “brunswickdrgclip.tif.”   
• In the Table of Contents, right-click on the Brunswick _roads layer (its name, not the symbol) and  
• Click Open Attribute Table. 

 

 
 
The attribute table associated with the Brunswick _roads layer displays. Each record represents an individual 
feature - in this case, a road.   

• Scroll to the right to see all the attributes describing this layer.   
 
This road layer was developed for the purposes of assisting emergency response. What are some of the 
attributes that would make responding to an emergency such as a house fire easier? 
 

• Close the attribute table. 
 
Step 8 – Add map tips to your display 
 

• From the Bookmark menu select MerrymeetingBay.  This zooms out to show a larger area. 
 
Map tips are text that represents a single feature attribute; map tips display when you hold the mouse pointer 
over a feature. They are an easy way to get attribute information for a specific feature. 
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You can specify which field displays by setting it in the layer's Properties dialog. 

• In the Table of Contents, right-click the Towns layer name and click Properties.  
• In the Properties dialog, click the Display tab. Click the box to Show Map Tips.  

 
 
You can choose the attribute that is used as the map tip field in the Fields tab of the Properties dialog box. The 
default that ArcGIS chooses (Name) is usually the most useful for a map tip.  
 

• Click OK to close the Properties dialog.  
• Hold your mouse pointer over anywhere on the map and the name of the town should appear. 

 
Step 9 – Label features 

In this step, you will label features on your map using labels stored in one of the layer’s Attribute fields.  

• In the Table of Contents, right-click Towns  
• Select Label Features. Labels appear for the towns. If some of the towns are not labeled, enlarge the 

display area. 
 

Step 10 – Add layers to the map document 
 

• Click on the Add Data button .   

• Connect to your student folder in the Microwave Course Directory folder by clicking on the  connect 
to folder button.   

• When the “Connect To” folder dialog box opens up, navigate to your student folder and click OK.   
• When the Add Data dialog box opens your student folder, go into the Exercise1 folder and  
• Select the layer bald_eagle.shp and add it to your project.  This layer shows the location of bald eagle 

nests around Merrymeeting Bay.   
 

• From the File menu, choose Exit to close ArcMap. Click No when you're prompted to save changes. 
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ArcCatalog is a partner program to ArcMap.  It provides a way of managing the different types of data you 
work with in a GIS.  Because spatial data can be more complicated than other types of data like spreadsheet 
files, you should always use ArcCatalog when looking at your data, copying or moving data, or doing minor 
edits, rather than using Windows Explorer.    The next part of the exercise will walk you through how to use 
ArcCatalog to explore data.   
 
Step 11 – Start ArcCatalog   

• Click the Start menu, then click Programs, ArcGIS, ArcCatalog  

• When ArcCatalog opens, click the Connect to Folder button .  
• Navigate to your student folder within the ES201 Microwave Course Directory, where you will be 

saving data;  
• Click OK. 

The ArcCatalog Window 

The ArcCatalog  window has the Catalog Tree on the left where all of the data layers are listed.  On the right are 
three different tabs which give you three ways to look at your data: 

 The Contents Tab – shows a list of data within a folder. 
 The Preview Tab – provides you with a way to look at your data before you add it to ArcMap. 
 The Metadata Tab – is where you store important documentation about the spatial data such as who 

created the data, when and why.   

 

 

 

 

 

Catalog Tree 

 

 

• In the Catalog Tree on the left side of the ArcCatalog window, click the plus sign (+) next to the folder 
connection you just set up. If you can’t see the entire table of contents you can widen it by holding the 
arrow over the grey bar in the middle of the dialog box until it turns into a double sided arrow and 
moving this line to the left or right.  

• Go into the Exercise 1 folder by clicking the (+) sign next to it in the catalog tree. 
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Step 12 - Preview features. 

Now you will preview and display features.   

• On the right side of the ArcCatalog window, click the Preview tab to make it active.  
• In the Catalog Tree, click on towns to make it active (see graphic below).  
• In the Preview dropdown menu at the bottom of the Preview window, choose Geography. You see the 

town polygons.  
• Next, in the Preview dropdown menu (below the preview area at the bottom of the window), choose 

Table. Now you see the town attribute table. Examine its fields. 

Take a few moments and 
examine the other data in the 
folder using either the Preview or 
Contents tabs. 

Next, look at a Metadata tab to 
get more info about the data. 

Once you have finished looking 
at the data, close ArcCatalog. 
 
Review the Checklist on the 
following page. 
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Checklist of things learned in Exercise 1: 

 How to map the network drive 

 How to use the Identify, Zoom, and Pan tools 

 How to use a Bookmark 

 What is the Attribute Table and how to access it 

 How to use Map Tips 

 How to label features 

 How to add layers to your map 

 What is ArcCatalog and how to Preview features; where Metadata is stored 
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Week 1: Exercise 2 – Displaying data in ArcMap 
 
 
In this exercise you will learn how to symbolize spatial as well as attribute data to make it meaningful and 
understandable.  Display of data is just one of the tools available through ArcGIS and other GIS software 
packages.  
 
Step 1 – Start ArcMap 
 

• Start ArcMap and click "A new empty map,"  
• Click OK.   
• If the Tools toolbar is floating separately on your desktop, drag it into the top, grey area so that it docks 

at the top of the screen.   
• Under the file menu, click on Document Properties.   

 
You should see this box (below left):  

 
 
 
 
 
 
 

• Click on the Data Source Options button 
• Select “Store relative path names.”   
• Click OK, then click OK again. 

 

 
 
This will allow you to more easily find all of the 
data that is associated with your project. 
 
 
 

 
SAVE YOUR PROJECT INTO YOUR EXERCISE 2&3 FOLDER – use only letters, #s, and/or the 
underscore mark in the file name.  
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Step 2 – Adding data in ArcMap 

In Exercise 1, you learned how to add data by using the Add Data button .   
• Click on the Add Data button and navigate to the Exercise2&3 folder (inside your student folder on our 

Microwave course directory),  

• Click on the MerrymeetingBay.mdb file,  
• Add all the layers inside it (but not the red toolbox).  There should be eight layers to add.  You can add 

more than one layer at a time by holding down the Control key and selecting all the layers you wish to 
add. 

 
Note that the order of layers in the Table of Contents is the order of how the layers are displayed – in the 
example below, the buildings56 layer is on top of the buildings98 layer.  Rearrange your layers so that the map 
makes sense.  (You can click and drag the layers to rearrange their order in the TOC.)   
 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

 
 
 
 

• SAVE your project!  



3                                   Perspectives in Environmental Studies GIS Lab                         E. Johnson, N.Olmstead   
 

Step 3 – Change the symbology for a layer 
 
In ArcMap, you can symbolize layer features in a number of ways. Varying the color, shape, and fill patterns of 
different layer types can help your audience interpret your maps. When creating layer symbology, you should 
always choose colors, shapes, and patterns that enhance the map reader's ability to distinguish between different 
areas on the map display. A clear legend facilitates map interpretation. A map that is not understandable is one 
that is not useful. 
 
In this step, you will change the color of the town polygons. 
 

• In the Table of Contents, right-click on the mmbtowns polygon symbol (the 

colored square).The Color Picker displays.  Experiment with changing the 
colors of the town polygons. 
 

Another approach for changing symbology is to use the Layer Properties box.   

• Right click on the word mmbestuarine.   
• Select Properties.  The Layer Properties box will open. 

 
 
 

 
There are a number of different tabs 
on this box.  Click on each of them 
and look at options that are available 
in each of these windows.   

• Click on the Symbology tab 
in order to change the color 
of this layer.   

• Click on the symbol box 
(circled).  A symbol selector 
dialog box will open up (see 
next page).   

• Change the fill color and the 
outline color so they are the 
same color.  

• Click OK twice 
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• Use the same steps to change the color of the mmbriver, buildings56, and buildings98 layers. 
 
ArcMap allows you to import a legend (symbology) that was created in an earlier project.  You will import the 
legend that was created for mmbroads in Exercise1.   

• Right click on mmbroads and open the Layer Properties dialog.   
• Click on the Symbology tab.  
• Click on the Import button on the upper right hand corner of the symbology tab.  A new dialog box 

opens up.  Select “Import symbology definition from an ArcView 3 legend file (*.avl).  
 

• Click on the folder button in order to 
navigate to your folder.   

• Click the Exercise 2&3 folder to select 
the Legend file.  Select mmroads.avl.   

• Click Open, then click OK.   
• In the next box, select FCC (a 

classification field for highways) as the 
value field, then click OK.   

• Click OK again. 
The mmbroads layer symbology should now 
resemble the roads layer from Exercise 1.  
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Step 4 – Examine attribute information 
 
Examine the attribute table for landuse98. This layer is comprised of various attributes that were developed 
from aerial photos of land surrounding Merrymeeting Bay.  We will be looking at land use patterns in 1956 and 
1998.  In the landuse98 attribute table, one of the column headings is LUCLASS (Land Use Class); this column 
lists different codes for each of the rows or records in the attribute table.  Below is a table containing the 
attribute codes and categories: 
 
CODE Category 
AGR Agriculture (cropland or pasture in current or recent use) 
COM Commercial (business or commercial predominant use) 
FOR Upland Forest (predominant land use = forest) 
IND Industrial (manufacturing facilities and associated lakes) 
OW Open Water (lake, river, or bay areas under water greater than a few inches deep at time 

of photography) 
RES Residential (homes and related neighborhoods) 
USS Upland Scrub-Shrub (usually abandoned agricultural field) 
UHE Upland Herbaceous (large expanses of lawn not obviously associated with residence) 
WET Wetland areas/intertidal zone 
 
Close the Attribute Table. 
 
Step 5 – Changing the symbology to reflect attribute information 
 
A layer’s display is meant to communicate a message. When defining a layer's display properties you must 
consider two issues: the message you are trying to communicate and who your audience is. Also, bear in mind 
the audience's ability to interpret the information presented.  One way to effectively communicate your message 
is to assign every feature in a layer a unique color or group features by an attribute value. 
 
 

• Open the Layer Properties for landuse56.   
• Click on the symbology tab.   

 
On the left of the box are options for 
displaying the different types of attribute 
information.   

• Click on the word Categories.  
You should see different options 
for displaying unique values.  
Make sure Unique Values is 
highlighted. 

• Make sure that the Value Field 
that has been selected is 
LUCLASS  

• Click on the Add All Values 
button.  Each of the categories 
will now have a unique color 
(see graphic below).   

• Click Apply. 
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• Double click each of the color symbols to change the color of the different land use classifications, so 
that the color relates to the color of the category (e.g., forestry is green).   

• Click Apply, then OK. 
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Step 6 – Use a fill pattern 
 
You will be adding land use categories for more than one year.  It will be helpful to differentiate between the 
years by using a transparent pattern for landuse98. 

• Move the landuse98 layer so it is on top of the landuse 56 layer (see previous page) 
• Turn on the landuse98 layer.    
• In the Symbology tab (in the Layer Properties box), add all values for LUCLASS. In order to change the 

fill pattern, stay in the Symbology tab in the Layer Properties box.   
• Double click on the first colored box next to the first land use attribute (AGR).  This will open up the 

Symbol Selector box.  
• Scroll down in the symbol box (displaying different colors) and examine the different fill patterns.  You 

can look for more fill patterns by clicking the More Symbols button.  Select a different fill pattern for 
each of the land use classifications.  Change the outline color to No Color. 

***If you select a fill pattern 
with a white background, you 
will need to make the 
background transparent by 
selecting the Properties button 
(circled) and then selecting 
No Color for the Background 
Color.   

Check to be sure the 
background is transparent by 
seeing if the gray background 
color shows through your 
symbol selector Preview (see 
Preview here, top right of 
box).  If the fill background is 
not gray, you need to fix it.  

This will allow you to 
differentiate areas that were in 
agriculture in 1956 and have 
been converted to a different 
land use by 1998. 
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Change the color and fill patterns until you can differentiate between the two layers.  Find an area that was 
agricultural in 1956, but is now forested.  What percentage of the overall study area do you think has been 
converted from agriculture? 
 
Symbolizing data in ArcGIS allows users to see changes in the landscape visually, but does not allow for 
quantitative analyses.  For example, you can pick out areas that have changed in land use (from forestry to 
agriculture) but it is impossible to determine the exact acreage of these changes visually.  ArcGIS has a number 
of tools, which you will learn about in Exercise 3, which will allow you to quantitatively answer questions such 
as these. 
 
Step 7 – Save your project!   
 
Checklist of things learned in Exercise 2: 

 Save your map document often! 

 How to store relative path names 

 How to import symbology from a legend file 

 How to add unique values to symbolize categories based on attribute table fields 

 How to use transparent symbology to see through a layer to the layer below 
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Week 1: Exercise 3 – Analyzing Data Using ArcGIS 
 
In this exercise, you will analyze changes in land use patterns around Merrymeeting Bay.  In the previous 
exercise, you used symbolization to get a sense as to changes that had occurred between 1956 and 1998.   
A more quantitative analysis can help us start to answer the following questions: 

 Could changes in land use explain, in part, the degradation of Merrymeeting Bay? 
 As land use continues to change, what are the implications for water quality in the bay? 
 What is the impact of residential development upon the bay? 

 
AGRICULTURAL LAND CONVERSION ANALYSIS 
 
Step 1 – Select features by their attributes 
 
We can symbolize spatial data based upon their attributes.  In Exercise 2, you symbolized different types of land 
use.  We can also choose to display data based upon their attributes – for example, in order to more clearly see 
changes in land use, we may only want to display one or two types of land use at a time.  In this case, we will 
display those areas that were agricultural in 1956 and in 1998. 
 
The tool that allows us to display data that meets a specific criterion is “Select by Attribute”  
 
1a. In the Table of Contents, make sure that landuse56 is turned on. 

 
 
1b. From the Selection menu, choose Select By 
Attributes. 
 
The Select By Attributes dialog allows you to select features 
by building a query. You will build a query by creating an 
expression for the landuse56 layer that selects polygons 
whose LUCLASS is equal to AGR (agricultural lands). 
Once selected, these features will be highlighted on the map 
and in the layer's attribute table. 
 
--In the Layer dropdown list, click landuse56.   
--For Method, choose "Create a new selection"  
--In the list of attribute fields, scroll down and double-
click on LUCLASS.  
--Click the equals sign button (=) in the middle of the 
dialog.  
--Next, click Get Unique Values button.  
--Scroll down the list of unique values and double-click 
on ‘AGR’. 
--Notice the expression you have created in the lower 
window: Select From Landuse56 where LUCLASS = 
AGR 
 
1c. Click Apply. Move the Select By Attributes dialog 

out of the way so you can see the map display.  In the display area, notice that certain polygons are 
highlighted – these are all of the areas that were agricultural in 1956.  
1d. Close the Select By Attributes dialog. 
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Next, you will create a new layer comprised of just those areas that you have selected.   

 
1e. Right click on the landuse56 layer name.   
   
1f. Click Data, then Export Data.   
 
1g. In the Export data window, choose Export: 
Selected features in the Export dropdown 
menu.   (These are the polygons that have 
LUCLASS=AGR).   
Choose “Use the same coordinate system as: this 
layer’s source data”   
Beside the “Output shapefile or feature class” bar, 
click the folder button.   
The Saving Data window will open. 
 
 

 
1h. From the Save as Type drop-down menu, select File and Personal Geodatabase feature classes. 

-Navigate to your Exercise2&3 folder 
and then double click into your 
MerrymeetingBay.mdb file. 
-Name the new feature class (layer) 
“mmb56_agriculture” 
Click Save.  You return to the Export 
Data window 
Click OK. 
 
1i. The program will ask you if you 
want to add the new layer to the 
map.  Click YES. 
 
1j. Unselect the 
selected features 
clicking on the Clear Selected 
Features button on the top tool bar 
 

1k. Now make sure the landuse98 layer is turned on, and then repeat these same steps in order to create a 
layer showing agricultural areas in 1998 (mmb98_agriculture). (Steps 1a – 1i). 
 
In order to better see which areas have been converted from agricultural lands, turn off the landuse and 
building layers so that you can see the agricultural lands from each of these two years.  Change the fill 
pattern of the new mmb98_agriculture layer so that you can differentiate it from mmb56_agriculture. 
(Hint: a pattern, with a transparent background, would work well here.) 
 
Turn off landuse 56 and landuse 98 and compare the two new agricultural layers.   
This is an easier way to visualize the change in agricultural lands between 1956 and 1998. 
Although it is possible to visually differentiate the changes, it is not possible to visually quantify these changes. 
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Step 2 – Calculating statistics using attribute values. 
 
Next you will quantify how much land was agricultural in 1956. 
 
2a. Open the attribute table for mmb56_agriculture.  Scroll over until you find the column named 
ACREAGE.  This column lists the acreage of each of the polygons that you selected from landuse56.                               

 
2b. Right click on the 
word ACREAGE.  
Select statistics.  A box 
will pop up with 
statistics for this 
column. Note the 
various statistics that 
this tool gives you: the 
count of all records 
(here, polygons) in the 

table; acreage of the smallest and largest records (minimum and maximum); sum of all the acreage; mean 
acreage; the standard deviation from the mean; and a frequency distribution (how many records fell into each of 
several different acreage categories).    
 
What was the total amount of farmland in 1956?  
Answer question #1 on the Exercise 3 questions (at the end of this handout). 
 
Repeat these same steps in order to determine how many acres of agricultural land there were in 1998. 
 
Record your answer on question #2. 
 
By inspecting the map, estimate which of the towns has lost the most amount of agriculture.   
At this point, one of the questions that we need to answer is what is happening to this agricultural land – is it 
being converted to new homes? 
 
Another important capability of a GIS is the ability to analyze relationships between features.  In this case, we 
want to find the answer to two questions: 
 

• Is there a relationship between loss of agricultural land and increases in buildings in these same areas?  
(Step 3) 

• If we are losing agricultural land, what other types of land use is this land converting into – residential, 
forest, industrial? (Step 4) 

 
If we visually inspect the data, it is hard to pick out these trends; our minds just don’t allow us to easily do this 
type of analysis.  In ArcMap, like many other types of GIS software, we can compare two different types of 
spatial information to see if there is any correlation. 
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Step 3 – Select geographic features using spatial relationships 
 
To answer the first question, we will need to determine how many buildings were located on agricultural land in 
1956 and how many buildings are located on these same parcels in 1998.  By comparing the number of 
buildings in 1956 with the number of buildings in 1998, you can get a sense as to whether agricultural land has 
been converted to residential development.   
 
In order to do this, we will be using a tool called “Select by Location.”  The Select by Location tool allows us to 
select features which meet a specific spatial criteria based upon their location.  In this case we want to find 
buildings (points) which fall within the boundaries of the agricultural parcels (polygons) from 1956. 
 
3a. Turn on the buildings56 layer so that it is visible 
 
3b. From the Selection menu, choose Select By Location. 

  
3c. In the Select By Location dialog, select items in 
the dropdown lists so that the selection query reads, 
"I want to select features from the buildings56 layer 
that are completely within the features in this layer:  
mmb56_agriculture."   Click Apply.  Close the Select 
by Location window.  
 
All 1956 buildings that are located on land that was 
agricultural in 1956 should be selected (display as 
blue).  Zoom into one area of the map to find where the 
selected buildings are.   
 
3d. Open the Attribute Table for the buildings56 
layer.  At the bottom of the table in parentheses, see 
how many records are selected.  Each record 
corresponds to one building.  How many buildings are 
located on formerly agriculture land?   
 
Answer question # 3. 
 
3e. Clear the buildings that were selected by clicking 
the Clear Selected Features button at the top. 
 
3f. Turn off the buildings56 and turn on the 
buildings98. Now using Select by Location and these 
same steps, find out how many buildings were located 

on 1956 agricultural land in 1998.  How many buildings existed in 1998 on land that was agricultural in 1956?  
Answer question # 4. 
 
3f. Go back to Step 1 of this exercise (Exercise 3) and use the steps to figure out how to create a new layer 
that shows only those lands that are not agricultural in 1998. (Hint, use this expression: “[LUCLASS] <> 
'AGR'” to select the features, and then Export Data to make the new layer.)  Save this new feature class as 
mmb98_not_ag into your MerrymeetingBay.mdb.  Display this new layer in your map. 
 
How many acres of non-agricultural land uses were there in 1998?  Answer question #5. 
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Step 4 – Using ArcToolbox to clip files 
 
To answer our second question – what land use types exist on land that was formerly agricultural, we will need 
to use ArcToolbox.  ArcToolbox is a component of ArcGIS with a number of different tools.  In this exercise, 
you will be using the Clip tool. 
 
You will identify areas that were agricultural in 1956 and were no longer agricultural in 1998.  Then you will 
find out what the breakdown is for each of the parcels in terms of their 1998 land classifications.    To do this, 
you will follow these steps: 

• You have already created a layer showing areas (polygons) that were agricultural in 1956 
• You have already created a layer showing areas (polygons) that are not agricultural in 1998 (i.e., they 

are one of the following categories: residential, commercial, forest, etc.) 
• By overlaying this non-agricultural land from 1998 with areas that were agricultural in 1956, you will be 

able to see where agricultural land has been converted to other land use types (those areas that overlap 
both layers meet this criteria) 

• Clip the 1998 polygons so that you have created a new layer that meets the criteria that it was 
agricultural in 1956 but is no longer agricultural in 1998. 

• Analyze the new 1998 (non-agricultural) polygons to see what land use types they are composed of. 
 

In the example below, the land that was agricultural in 1956 is indicated by cross-hatching.  Land that is not 
agricultural in 1998 is indicated by the shaded areas.  Those areas that have cross hatching over shaded areas are 
places that were once farms and were converted to another use by 1998. 

 
   
 
 
 
 
This area was farmland in 
1956 and is no longer 
farmland in 1998. 
 
 
 
This area was farmland in 
1956 and is still farmland in 
1998. 
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The Clip tool is like a cookie cutter, it allows you to cut out those areas that were agriculture in 1956, but are no 
longer agricultural in 1998.   Your result will look something like this: 

 

 

 
 
Your map will only show 
shaded areas that were 
once farmland and are 
now no longer farmland. 
 
 
 
 
 
 
 
 
 
 
 

4a. Open ArcToolbox by clicking on the red toolbox in the top of the ArcMap Window. 
When you click on this tool, a new window, the ArcToolbox window will open in your ArcMap window 
between the Table of Contents and Map View.  
 
 
 
 
The ArcToolbox icon is located hereT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ArcToolbox 
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There are a lot of tools in ArcToolbox that we will not need in this exercise.  Click on the boxes next to some of 
the toolboxes to see what types of tools are included.  By double-clicking on a tool, you will bring up an 
individual tool window that explains what the tool will do and gives an example of how it works.   
 
We’ve created a specialized “ES201 toolbox” with just the tools that you will be using in this exercise.   

 
4b. Right click on the ArcToolbox Window (anywhere in the 
center white area).  Select Add Toolbox.  Navigate to 
Merrymeetingbay.mdb.  Double-click  it and select the red 
toolbox called “ES 201.”  Click open.  A new red toolbox will 
show up in your ArcToolbox window.   
 
4c. Open the toolbox by double clicking on it.   You will see the 
following tools: Buffer and Clip.  We will be using both of these in 
this part of the exercise. 
 
4d. Double click on the Clip tool.   
In this step, you are going to clip the polygons or parts of polygons 
that were agricultural in 1956, but were not agricultural in 1998, and 
make a new layer out of them. Read the Help section to visualize 
what the Clip tool is doing.  If you need more info about what a tool 
does, click the Help button at the top of the Help panel. 

 
Make sure the two layers you 
want to use in the Clip are 
turned on in the Table of 
Contents. 
 
In the Clip window, you need 
to specify the Clip 
parameters.  For the input 
layer to clip, choose 
mmb98_not_ag from the 
dropdown menu. For the clip 
features, choose 
mmb56_agriculture.  Beside 
the Output Feature Class bar, 
click the Folder button and 
save the Output Feature Class 
(layer) as a feature class 
named nonaguses56_98 in 
the MerrymeetingBay.mdb in 
your project folder. 
 

Click OK.  This may take a 
while – so take a break – get 
up and stretch! 
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Click on the new layer and 
examine it to make sure that it 
does not overlap with any 
agricultural polygons in 
landuse98.  This is a check to 
make sure you did it correctly. 

The area of each of these 
polygons is calculated in square 
meters (m2).  In order to analyze 
the change in acres, you will 
need to add a new column to the 
attribute table that calculates the 
area value in acres.   
 
 
 
 
 
 

 
 
 
 
 
4e. Check to be sure that ArcCatalog is closed.  You may run into 
problems in this next step if ArcCatalog is open. 
Open the nonaguses56_98 attribute table.   
Click on the Options button and select Add Field.  Name this new 
field Acres and select Float as the type.  Click OK.  The table will 
now have a new column at the end with <Null> in each of the rows. 
 
 
 
  

4f. Right click on the Acres column heading and 
select Calculate Geometry.  Click Yes when the 
pop-up box appears asking if you want to continue.  
In the Calculate Geometry dialog box, select Area in 
the Property dropdown menu. In the Units dropdown 
menu, select Acres US [ac].  
Click OK.   
 
The new Acres column should now contain the 
acreage for each of the polygons in your table.   
Click Save! 
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In addition to the spatial analysis tools that you have used (e.g, the Clip tool), the program includes other tools 
that allow you to analyze data quantitatively.  You will use these tools in order to determine the number of acres 
that fall into each of the non-agricultural land use categories.  For those areas (polygons) that are no longer 
agricultural, how many acres (or what percentage) are now residential or forest land?  For the next part of the 
analysis, you will use two tools: the Summarize Tool and the Graphing Tool.  The Summarize Tool is useful 
when you want to summarize information for many features or records.  For example if you have 20 polygons 
that are classified as residential, it will add all of these polygons together and summarize the area.   
 
 
Step 5 – Using the Summarize Tool 
 
In order to find the number of acres of each of the different LUCLASS categories in the new nonaguses56_98 
layer, you will use the summarize function.  The result of using the summarize tool is a new database file that 
adds up area for each of the Land Use classes. 
 
5a. Open the attribute table for 
nonaguses56_98.  Right click on the 
LUCLASS field name.  Choose 
Summarize. 
In the Summarize window, select Acres 
(the field you created, not “ACREAGE”) 
and then Sum as your choices.   
This will calculate the total (sum) of the 
acreage of each of the LUCLASS 
classifications.   
This new file will be a database file, or 
.dbf file.   
 
5b. Name this file sum_ag_conversion 
and save it into your Exercise2&3 
folder. (Use folder button to navigate 
there.)  Click OK. 
 
5c. You will be asked if you want to add 
this table to your project.  Click Yes.   
The sum_ag_conversion appears in the 
Table of Contents Source tab (see bottom 
of TOC).  It is a database table, so it will 
look different from the other layers in your 
Table of Contents window.   
 
Open the table for sum_ag_conversion by 
right clicking on it and selecting Open.   
 
Answer question # 6. 
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Step 6 – Making a graph 
 
Next you will make a graph of this database table so you can visualize the 1998 land use classifications for 
these converted agricultural areas; in other words, what has the farm land around Merrymeeting Bay been 
converted into? 
 
6a. Click on the Tools menu and select Graph and then Create 
This will open the Graph Wizard.  Select the following options on the screens that come up as part of the Graph 
Wizard. Set the dialog box to show the results of your sum_ag_conversion table. 

 

 

 

 

6b. Examine and then close the 
graph. It will be saved and will 
remain part of your ArcMap file.  
To access it again, go to the 
Tools menu and select Graphs. 
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Be sure to save your project!  Close both ArcMap and ArcCatalog. 
 
Checklist of things learned in Exercise 3: 
 
 

 How to Select by Attribute 

 How to Export selected features to create a new feature class (layer) 

 How to get Statistics for a column in the Attribute table 

 How to Select by Location 

 How to Clear selected features 

 How to use the Clip tool 

 How to Add a Field to the Attribute Table and Calculate Geometry for that field 

 How to create a database table by using the Summarize tool in the Attribute table 

 How to create a Graph from a database table 
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Exercise 3 questions 
 
 
1. How many acres of agricultural land existed around Merrymeeting Bay in 1956? 

 
 
 
2. How many acres of agricultural land existed around Merrymeeting Bay in 1998? 

 
 
 

3. How many buildings were located on agricultural lands around Merrymeeting Bay in 1956? 
 

 
 
4. In 1998, how many buildings were located on land that was used for agriculture in 1956? 

 
 
 

5. How many acres of non-agricultural lands were there in 1998? 
 
 
 

6. How many acres of agricultural land have been converted into: 
 

a. Commercial land?  
 
b. Forest land?   

 
c. Industrial land?  
 
d. Open Water?   

 
e. Residential land?  

 
f. Upland Herbaceous?  
 
g. Upland Scrub-Shrub (Abandoned Fields)?  
 
h. Wetlands?  
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Land Use Analysis within the Androscoggin River Watershed 
Nancy Olmstead, Eileen Johnson 

Perspectives in Environmental Studies GIS Lab – Week 2 Project 
 
Introduction 
Throughout the semester, we have been working on a project to investigate the Gulf Island Pond 
(GIP) section of the Androscoggin River.   In this GIS project, you will continue to investigate GIP 
and our control system, Lake Auburn (LA), using the spatial tools available through the ArcGIS 
software.  The goals of this project are twofold: first, you will create a map which illustrates the 
spatial data in a meaningful way; second, you will use some of the more quantitative tools of the 
ArcGIS program in order to compare the watersheds of GIP and LA.   
 
First, you will make a map which visualizes the areas we are studying, including the Androscoggin 
River, GIP, and LA.  You will symbolize our sampling stations according to the amount of turbidity 
and total phosphorus (P) found in the water column.  You will visualize the water quality 
classifications (Class A, B, C, etc.) of the river and the streams in the areas that drain into GIP and 
LA.  You will also have data on the land use within the watersheds that drain into GIP and LA.  
Land use data may be relevant to the GIP water quality problems due to non-point source pollution.   
 
Non-point source (NPS) pollution is runoff that drains into a waterbody by sheet flow of water; this 
is distinguished from point source discharges, such as paper mills (PMs) and municipal wastewater 
treatment plants, which pipe effluent directly into the river.  One of the arguments that the PMs 
made during the permit appeals process in 2007 was that regulators have underestimated the amount 
of NPS P pollution affecting the GIP system.  The PMs argued that NPS pollution, e.g., from areas 
of agriculture in the GIP watershed, could be an important part of the P pollution problem.   
 
Phosphorus inputs from NPS pollution are known to vary based on land use type (Reynolds and 
Davies, 2001).  Runoff from forests, grasslands, and other non-cultivated land has been shown to be 
low in phosphorus (Bashkin, 2002).  Even grazing land does not export much P in runoff (Reynolds 
and Davies, 2001).  Cultivated lands may export P, though much of this P will be bound to 
particulates (soil particles) and therefore only somewhat bioavailable (Bashkin 2002).  Agricultural 
lands that have been treated with manure may be a source of bioavailable P (Reynolds and Davies 
2001).  Previous studies of the entire Androscoggin River watershed have found that the watershed 
is mostly (85%) forested (Boyer et al., 2002), but we are aware of no study of the particular portion 
of the watershed that drains into GIP.  You will use the land use data to graphically compare the 
amount of different land uses within the GIP and LA watersheds.   
 
The degree of imperviousness of the land surface is also a factor in how much P may run off into 
waterbodies (Brabec et al., 2002).  Impervious surfaces are those which do not allow precipitation 
to soak into the soil slowly.  Higher volumes of water run off from these areas, and this runoff tends 
to carry more pollutants and sediment, which can both be detrimental to aquatic biota (Brabec et al., 
2002).  Different land use categories vary in their degree of imperviousness.  Examples of very 
impervious surfaces include roads and buildings, while vegetated areas vary in their degree of 
imperviousness – golf courses and lawns, for example, are much more impervious than mature 
forests.  You will have data on the extent of impervious surfaces in the Androscoggin watershed, 
and you will use those data to graphically compare the amount of imperviousness in the watersheds 
of GIP and LA.   
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Outcomes 
There will be three outcomes for this assignment: a PDF map, a word document of graphs, and an 
extended abstract which summarizes your conclusions in writing.  Print only the abstract. 
These are due at the end of lab on May 4, 5, or 6. 
 
1.  11x17 PDF Map, saved in your Student Folder, in the GIS folder – to include: 

• Water quality classifications for streams and rivers 
• Sampling sites classified by amount of Turbidity and Total Phosphorus in the water 
• Land uses within the areas of interest 
• Impervious areas within the areas of interest 
• Focus in on the two small watersheds for the map – large one is too big for 11x17 
• All features detailed in the separate “Making a Layout” handout (legend, etc.) 

 
2.  Word document, saved in your Student Folder, in the GIS folder, composed of six pie charts: 

• % of impervious and pervious area of GIP entire watershed 
• % of impervious and pervious area of GIP subwatershed 
• % of impervious and pervious area of LA watershed 
• % of land in different land use categories for GIP entire watershed 
• % of land in different land use categories for GIP subwatershed 
• % of land in different land use categories for LA watershed 

 
2.  Abstract, double-spaced and double-sided, not to exceed 500 words – to include: 
Written summary of your conclusions regarding the questions: 

• Overall, how does GIP compare to LA in terms of percent of the watershed in 
impervious area and the percents in different land use categories?     

• Is GIP likely to be receiving significant amounts of P from NPS pollution?   
Why or why not?   

• Knowing what we know about the varying amounts of sediment P in GIP compared to 
LA, do our data support the PM’s contention that NPS P pollution is a major factor in 
the GIP water quality problems?  Why or why not?   

 
Data you will have 
1.  Waterbody data provided by the Maine DEP (Department of Environmental Protection).  These 
data show all waterbodies within the Androscoggin watershed and their water quality classification. 

• andro_streams_water_quality 
• andro_ponds – no water quality info because all Maine ponds are Class A 
• andro_rivers_water_quality – all rivers in the Andro watershed 
• andro_streams_upstream_from_GIP – although these data do not include water quality 

info, they include just the streams that feed GIP 
 
2.  Watershed data is also available from the USGS (United States Geological Survey).  For this 
exercise, four different watersheds have been provided. 

• andro_watershed – the entire Androscoggin River watershed showing all subwatersheds 
• andro_watershed_LA – the entire watershed of LA; all the land draining into LA 
• andro_watershed__GIP – the entire watershed of GIP; all the land draining into LA 
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• andro_subwatershed_GIP – the subwatershed for GIP; not the entire GIP watershed, 
just the immediately adjacent watershed 

 
3.  Land Use Data 

• andro_landuse – all land use types within the entire Androscoggin River watershed 
• andro_impervious_areas – all lands of the Androscoggin watershed classified as to 

whether they are impervious or pervious 
 
4.  androscoggin_river – shows you the course of just the Androscoggin River, in case you are not 
familiar with it.  This may be useful just for orienting yourself (probably not for final map).  
 
5.  maine – the towns of the southwest portion of Maine.   
 
Suggested steps 
1. Create a project using data available in the “Androscoggin” folder in your GIS folder, inside 

your student folder 

a. Add all of the feature classes within the androscoggin geodatabase 

b. Look at the metadata for these layers in order to understand the data, their sources, 
and the attributes in the attribute tables 

2. Symbolize the data in order to see what they can tell you about the water quality of GIP and 
LA 

a. Symbolize streams and rivers based upon water quality classification 

b. Symbolize the land use and impervious data.   
Note: Land_Use.lyr is a layer file that includes the symbology for the different land 
use types.  Since you will eventually have multiple land use layers in your map, this 
will allow all of your various layers to have the same symbology for the different 
land use categories.  Once you have added the  “andro_landuse” layer, review last 
week’s handout on importing a previously defined symbology.  (Exercise 2 – page 
4.)  In the Import Symbology window, select the option to “Import symbology 
definition from another layer in the map or a layer file,” then navigate to the 
Land_Use.lyr file in your folder. 

 
c. Note: features outside of Maine are not subject to Maine law and therefore are not 

included in these data sets 

3. Using the separate instructions, add the excel spreadsheet with the locations of your 
sampling points and their water quality data.  Display the locations of the sample points and 
symbolize the information based on the following parameters.  Refer to last week’s 
instructions on displaying data.  You may want to use graduated symbols or graduated color 
depending upon which one you think displays better: 

a. Total_Water_Phosphorous_ppb_2009 

b. Turb_NTU (Turbidity in NTU) 

4. You will analyze the relative percentages of impervious/pervious surfaces and different land 
use types within three different scales of watersheds: 
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a. The entire GIP watershed – the whole area within which NPS pollution potentially 
affects GIP 

b. The entire LA watershed 

c. The GIP subwatershed – this is a more similar size to the LA watershed and is also 
the most immediate source of potential NPS pollution, since runoff from this area 
flows directly into streams feeding GIP, rather than into streams feeding waterbodies 
farther upstream in the Androscoggin watershed.   

To complete the analysis of land uses and impervious areas, refer to last week’s handout and 
the notes below; you will need to use the following steps: 

d. Symbolizing by unique value or importing a previously defined symbology 

e. Clipping of data (“andro_impervious_areas” and “andro_landuse”)  to the watershed 
of interest 

f. Add a field (“Acreage”) and then calculate geometry (US Acres) 

g. Add a field, then right-click on the new column and use the Field Calculator 
command to calculate the percent of total acreage that is represented by each land 
use category.  [Hint: before you do the Field Calculator, you’ll need the total (sum) 
of acreage, from the column you just made (f), in order to calculate the percentage.  
In the Field Calculator, use the formula = [Acreage]*100/ (the sum of acreage)]  
Once you calculate the column, you can adjust the # of decimal places shown by 
right clicking on the column heading and selecting Properties.  In the Field 
Properties dialog box, click on the little box next to where it says “Numeric” and you 
can adjust how many decimal places display in the attribute table. 

h. Graph results using pie charts.  (Note: you should set the symbology of the pie chart 
to match the symbology of the land use categories as displayed in the map, by setting 
the Color  to “Match with Layer.”) 
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Adding Point Data to ArcMap. 
 
Locations can be added to ArcMap from a variety of file types:  word files, txt files, or excel spreadsheets.  
In this exercise, you will add the locations of core sites that you sampled earlier in the semester to your 
ArcMap project.  The locations of the sample sites were collected with a GPS unit and then downloaded 
into an Excel spreadsheet. Locations were recorded in latitude and longitude.   
 

1. Add the excel file “AndroWaterQuality” to your project   
a. Click on Add Data 
b. Navigate to this spreadsheet “AndroWaterData2009_2010” 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
c. You need to add individual worksheets when adding data in excel format, so click on 

the spreadsheet.  There are two worksheets associated with this excel file.  Select the 
worksheet titled “WaterQualityData” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
d. If you cannot see the excel spreadsheet in your map document, click on the Source tab 

located at the bottom of the left hand Table of Contents (where all of your data layers 
are displayed). 

 
e.  

 
 



2. Right click on “WaterQualityData” in the lefthand Table of Contents and select  “Display XY 
Data”  

 
 
3. A Dialog box “Display XY Data” will display. Make sure that X Field is set to Long and the Y 

Field is set to Lat   
 

4. You will need to set the spatial reference for this data.  It 
was collected in Latitude and Longitude which is a 
Geographic Coordinate System.  Click on the Edit 
button under “Coordinate System of Input Coordinates”  

 
a. At the next dialog box “Spatial Reference 

Properties” click on Select 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 



 
b. Then click on Geographic Coordinate 

System 
c. Next click on North America 
d. Finally Click on the file “North 

American Datum 1983.prj”   Click on 
Add 

e. Back in the Display XY Data click on 
OK   

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5. If you get an error message “Table Does Not Have Object-ID Field,” Click OK 
6. You should see your points displayed on your map. 
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